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INSTALLATION AND START UP INSTRUCTIONS 

In Windows:   

1. Load the enclosed CD-ROM into your CD-ROM drive.  Open the Folder 
called “FMP 5.5vla”.  Double click the Setup.exe file (or “RUN” it from your 
Start Menu).  This will prompt you for a password, which is supplied 
separately in your delivery cover letter.  You should enter a user name that will 
help you identify this computer (“Door”, etc.) and your company name.  Select 
TCP/IP as your networking protocol. 

2. Copy the contents of the FMP Plugins subdirectory and place them in the 
FileMaker System folder at:  C:\Program Files\FileMaker\FileMaker Pro 
5.5\System 

3. Enter Control Panels on your computer and double click Fonts.  From the 
File pulldown menu there, select Install New Font and browse to your CD, 
selecting the Code39S1 font. 

4. From the CD, copy the file called !Clickme.FP5 and place it at a convenient 
location on your C: drive.  Right click on it, select properties and remove the 
read only attribute.  Create shortcuts to this file and place them on your 
desktop, Start Menu, and wherever else you like. 

5. Copy the entire Folder called RW5 from the CD and place it on your C:\ 
drive.  Open it, type Ctrl-A to select all files, Right click on any of them, select 
properties and remove the read only attribute.  (Any files you copy from a CD 
will be read only; this must be changed to allow you to enter data. 

6. Double click on the !Clickme.FP5 file (or any shortcut to it).  Click the large 
button to Log On.  The very first time you do this, you may have to “guide” the 
program to the !Menu.RW5 file located in C:\RW5.  After doing this once, the 
program will remember the location. 

 
If you are in a single user setup, with no networked workstations:  After you first 
launch and log onto ReportWare, go to the Edit pulldown menu and select 
Application Preferences and indicate <none> as the network protocol.  This only 
needs to be done once when the software is first installed and will allow files to open 
more quickly since they won’t try to launch as multi-user for guest access.  If you are 
in a multi-user situation, follow the instructions below.  You may change from single 
to multi-user anytime without reinstalling the software. 

Network Installations: 

ReportWare includes full support for multi-user, networked situations.  To use our 
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networking, you must install Windows peer to peer networking with either IPX/SPX 
or TCP/IP networking.  Obviously, cables and hubs and such must be put in place.  
Any competent computer consultant should be able to easily set up a suitable 
network for you if you don’t already have one.  The subdirectory in which the main 
ReportWare files are housed, C:\RW5, should NOT be shared on the network.  Your 
host machine will use ReportWare’s internal networking to go around Window’s 
privileges; guests must NOT directly access data files through Windows. 
 
After setting up your network and making sure all computers can “see” each other 
over it, you can set up ReportWare’s networking.  Any machine may act as host for 
ReportWare, with the others acting as guests.  You should select your best and 
fastest machine as host.  It may or may not be your primary network server for other 
purposes.  It may be running Windows 95, 98, 2000, ME, XP or NT 4 Server or 
Workstation.  Guests may be running any of these operating systems (you can mix 
and match if you like). 
 
On the selected Host machine, follow the installation instructions above for a full 
install.  Go to the Edit pulldown menu and select Preferences and indicate the 
network protocol you have chosen.  Next, click on the Utility Functions button on the 
Main Menu and hit the button to Set All Files to Multi-User.  This causes all files to 
be available to guests on the network.  If you quit the program or shut down this 
machine, all guests will be disconnected. 
 
On each Guest machine, install FileMaker Pro, the Plugins and Font as above.  
Copy on the !Clickme.FP5 file, but do NOT copy  the RW5 folder (this only resides 
on the host).  Double click !Clickme.FP5 to launch the program and click the button 
to Log on.  The Host machine must already be hosting all files.  If you get a locate 
files dialog, point the program to !Menu.RW5 on your host.  After doing this once, 
the program will thereafter “remember” where its host is and require no unusual 
actions from users. 
 



 

ReportWare Cabaret Management & Timekeeping © 1995-2001, revised 7/1/2001 Page 7 

(888) 737-9273 

PASSWORD ENTRY 
When you begin ReportWare, you may be prompted to log on and type in your 
password.  This may initially be disabled, as described below. 
 
For a brand new installation of ReportWare, select a user of “DEMO” and a 
password of “DEMO”.  Passwords are case sensitive.  After you have logged on, 
you will be able to set up your own passwords as you please, and you may replace 
the DEMO password. 
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BASIC OPERATIONS 
You are now presented with ReportWare’s Main Menu. 
 

 
Most of you will see the menu above with the words “Current User: PW Disabled” 
displayed on the screen.  The password function may be enabled using the utility 
functions described later.  If this function is enabled, and you are a manager and 
have been provided with a password, you should identify yourself by clicking on the 
“Set/Reset User & Access” button at the lower left.  Select your user name by 
clicking on the pop up menu and enter the password given to you by your 
supervisor.  If you are establishing your passwords for the first time, please see the 
section under Administration:  Assigning Passwords. 
 



 

ReportWare Cabaret Management & Timekeeping © 1995-2001, revised 7/1/2001 Page 9 

(888) 737-9273 

INITIAL SETUP 
 
The first step in using your ReportWare software is to set up your Cabaret 
preferences.  This is a list of information that tells the system how to function for your 
cabaret. 
 
Click on the Preferences button from the Main Menu to set up your company wide 
preferences.  At the initial preferences screen, click Continue.  If your password 
allows access, you will be shown the following menu.  Click on each tab and sub tab 
to see the choices offered.   
 

 
The following preferences must be set from the Main Prefs button: 
Corporate Name:  Please enter your corporate name.  This is the name of your parent corporation 

and will print on the state New Hire Report. 

Corporate Address / City / St / Zip:  This is the address of the parent corporation and prints on 

the state New Hire Report. 

State EIN:  Enter your state Employer ID number for tax filing. 

Federal EIN:  Enter your federal Employer ID number for tax filing. 
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Pay Overtime on > Hrs:  Enter the number of hours that must be worked in a week before overtime 

is paid to an employee.  This will be 40, unless your state or internal policy dictates a lesser number. 

Timekeeping Input Mode:  Enter the type of input device that you are using to clock in employees. 

Reader Mode:  This is only applicable if you are using hand readers.  If you are using hand readers, 

you will find this mode setting in your Biometric Manual. 

Accounting Week Starts on:  The day of the week your payroll week begins on. 

Years til 401K:  Number of years until an employee is eligible for 401K benefits. 

Std Hrs per year:  Number of standard work hours in a year.  We recommend that you set this to 

2080. 

Work Days per year:  Number of standard work days in a year.  We recommend that you set this to 

257. 

Minimum Wage:  Current federal minimum wage.  $5.15 at the time of this shipping. 

Allowable Tip Credit:  Current Federal allowable tip credit is $3.025.  Your state may have different 

or no allowable tip credit. 

SIT State:  State in which the club is located. 

Show Print Setup Dialogs:  Do you wish for each report to prompt you for the printer on which to 

print?  If so, enter Yes here.   

Auto Print Time receipts:  Do you wish to print a receipt for your non-dancers as they clock out? 

Track Tips and Sales:  Do you wish for the system to automatically track tips and sales for 

management reporting?  This should normally be Yes.  If you do not have any tipped employees, you may 

set this to No. 

Auto Set Emp ID = SSN:  The Employee ID is used by timekeeping to identify your employees in 

your Payroll system.  If you are using their social security number as your employee number, you may set 

this to Yes and the system will ensure that these two fields are set the same.  If you select No, you must 

set up a separate Employee ID when you establish a new employee. 

 
Press the Depts button to enter or see a list of your departments. 
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You may setup your Divisions, Departments, or Areas.  The system is shipped with 
the sample data shown above to get you started.  You may identify the starting and 
ending times of each of your shifts.  These shifts are later used in the Timekeeping 
reports to identify if your non-dancers are arriving early or late for their shift. 
 
Press the Dances button for additional Dance preferences. 
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Set the following preferences on this screen: 
For Dancers clocking in at or after (The Club keeps):  The club will retain the amount 

entered under The Club keeps, depending on the time that the dancer clocked in.  Enter a dollar amount 

(without the dollar sign).  For example, $20.00 may be entered as “20” (do not enter quotation marks). 

Plus _____% of remaining cash from dances sold:  Enter the percentage of the dance 

revenue collected by the dancer above Club Keeps amount which the club wishes to retain.  Enter a 

decimal number.  The system will convert it to a percentage.  For example, 20% should be entered as 

“.20”. 

Plus _____% of DncDls redeemed: If the club charges a discount percentage on dance dollars, 

enter that percentage here, as a decimal figure.  In the example above, a dance turning in a $20 dance 

dollar, receives $16, with the club retaining $4 (or 20%).  

Plus _____% of Credit Card tips:  If you charge your tipped employees (other than dancers) for 

credit card handling, enter that percentage here as a decimal figure.  It should be your actual credit card 

handling cost, not to exceed 5%. 

Table Dance Price:  Enter the price charged for a table dance. 

Value of Champagne Tickets:  Enter the value of your champagne tickets, if you use them. 

Name for Dance Dollars:  What do you call your dance dollars.  It should be small enough to fit in 

this space in order to fit on reports.  Please abbreviate if necessary.  

Dance Dollars are only for:  If you want to collect a discount from dance dollars that is greater than 
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your credit card processing fees (what you pay your credit card processor), then dance dollars must be 

used only for dances (set this field to Dances).  If you set this to Tips, you should not set the Plus % of 

Dance Dollars redeemed to greater than 5%.  (Call us with any questions). 

Separately track Credit Card Dances:  If you directly charge customer’s credit cards for dances, 

rather than using dance dollars, you should enter a Yes here. 

Track VIP & Promos:  If you would like to include the tracking of the use of your VIP rooms or the 

attendance of promotions by your dancers for you, enter a Yes here. 

 
Press the Collect Amts button to continue to enter Cabaret preferences. 
 

 
 
The preferences on this screen are used to identify collection amounts for 
Entertainers. 
 
Tax Entertainers:  Check Yes for IRS compliance and to have tax withholding calculated according to 

your state’s and Federal rules.  Only select “No” if you have been instructed to do so by your attorney and 

understand that by doing so you are acting at your peril and contrary to ReportWare’s recommendation.  

Failing to collect and remit taxes may result in huge liability to the IRS. 
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Show Collect amounts as cash net of Champagne and Scrip:  Mark this Yes to take 

advantage of ReportWare’s new feature and to show collect amounts as net cash (a positive number in 

the Collect box in Dance Times show how much the Dancer owes the Club; a negative number shows 

how much cash the club should give the Dancer). 

For the Has and Gets matrix:  If the Dancer has already collected her cash for cash dances from 

the customer (as is almost always the case), mark “Has”. 

For Scrip and Credit Card Dances (called “DncDlls” in the screen above):  If the 

Dancer cashes out throughout the night rather than at checkout, mark “Has”.  If all Scrip and Credit Card 

Dances are accumulated and only paid at check out, mark “Gets”. 

For Champagne and Additional Pay, the same rules apply:  If she has already cashed in 

or been paid prior to checkout, mark “Has”; if she turns in all vouchers and gets paid at check out, mark 

“Gets”. 

Fees:  To charge Dancers a discount or percentage on their Scrip or Credit Card Dances, put in the 

discount percentage.  This must be entered as a decimal.  For example, to charge Dancers a 20% 

discount, enter “.2”.  The block for fees to customers provides a place for entering the amount of 

surcharge imposed upon customers for selling them Scrip or Credit Card dances.  This amount doesn’t 

affect anything in this software release, but will be used in the future. 
 
To continue to with your Preference setup, select the Positions & Pay button on your 
screen. 
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The Position and Salaries tabs on this screen present all of your job positions by 
their EEO category.  You may set up all of your positions on these screens.  The 
information on these screens will allow fields to be automatically entered on the New 
Hire screen.  If you prefer, you may skip setting anything up on these screens, and 
simply enter it on the Employee New Hire for each employee. 
 
To continue entering your preferences, press the OSHA button.  This screen comes 
pre-established with OSHA pattern and injury codes. 
 
The Absence and Benefits button is next. 
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This is the screen where you identify the codes that you use for Full and Part Time 
regular employees.  Also you establish the codes later used in absentee reporting 
here.  The Benefits button tracks the codes used in Benefit reporting. 
 
The last Preference button is the Passwords and Evaluations button. 
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The Phrases button establishes the phrases that are later used in the Review 
process.  You must first set up your evaluation categories.  These are the categories 
by which you will rate your employees. 
 
Next you set up a phrase that is associated with each rating.  For example, a 5 may 
always be deemed Average. 
 
The schedule button allows you to schedule when evaluations will be due. 
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The Password button from the Preferences screen takes you to the screen that 
allows you to set up user ids and passwords.  These control and log access in a 
more detailed fashion for those who elect to enable secondary passwords. 
 

 
Initials go in the first field, and other information is entered as displayed in the above 
example.  You may type over any demo data you see to enter real data.  Access 
Levels are numeric, from 1 (lowest access) to 10 (highest access for senior 
management).  If you use a touchscreen terminal for cashiers to access 
ReportWare, enter numeric passwords. 
 
From this screen, you may access the “Security Levels” button to set up which 
access level is able to perform which functions: 
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This completes all set up for company wide preferences.  You need not access 
these screens again until you change some item set up here.  Return to the Main 
Menu using the button provided. 
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ADMINISTRATION – NEW HIRE SETUP 

Main Data Screen: 

To enter a New Employee record, select the New Employee button from the Main 
Menu. 
 
You will be presented with a screen requesting the employee’s social security 
number.  Every employee must have a social security number.  The system verifies 
that it does not duplicate one already on file. 
 
Enter the social security number and press Continue.  It is not necessary to enter the 
dashes.  Simply type the 9 digit number and hit continue. 
 
The Main Data Screen will appear: 
 

 
 
“Employee ID” accepts whatever number you may use to identify your employees.  
This ID must be unique -- no two people can have the same ID number.  If you try to 
enter a duplicate ID number, the computer will stop you.  This ID must be a number 
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(not alpha-numeric) and will be used when clocking in dancers and other 
employees. 
 
Go from one field to the next by pressing the tab key or by using your mouse.  On 
some pop-up lists, you may select the first letter of the choice then press the enter 
key.  Shift-tab skips backwards through the fields.   
 
The field “notes to staff” will display information to whoever checks in employees as 
they come in each day.  This is a free-form field to allow you flexibility.  Examples of 
useful entries in this would be “5/1/95 - needs updated W-4 -RR” or “5/1/95 -
Suspended for two weeks -RR”.  This provides a date, what to look for, and the 
initials of the person requesting it. 
 
After completing this screen, press the file tab button to the right side to go to the 
“Tax & Payroll” screen. 

 
 
Enter information on this and the next several screens.  Of particular note is the 
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“Payroll ID#” field.  This is used to set up the payroll ID for this person as assigned 
by ADP, Paychex, or your other payroll processor.  Actually, you can enter data in 
any order, but it’s important to be thorough and not skip anything lest it be forgotten 
later.  You can go back through a record and enter more information or alter what’s 
already there any time you wish. 
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Tax & Payroll Screen: 

 
Select the type of employee -- Salary, Hourly, or Entertainer.  If you have an entertainer 

who is also paid hourly sometimes for being a waitress or whatever, mark her hourly and put in her 

waitress payrate.  This will not change how she is handled when working as an entertainer.  Mark the pay 

cycle.  Only weekly or biweekly are recommended, as it is very difficult and confusing to track overtime on 

other pay periods.  Pay periods other than weekly or multiples of weeks are not supported.  Primary is for 

their primary job.  Secondary may be used for persons having two jobs at different pay rates.  Secondary 

accepts only hourly pay rates.  Employee Timekeeping (TKS.RW5) utilizes this information to handle 

employees performing two different jobs at two different pay rates.  This system will support a person 

performing up to three different jobs at different payrates (entertainer, Primary, and Secondary) 
 
Pay Overtime? Mark yes for everyone except persons you are certain are not entitled to overtime pay.  

If in doubt, call the Department of Labor and ask if the particular individual is exempt from overtime pay.  

Shortcut:  You can go ahead and mark persons about whom you are unsure as being entitled to overtime, 

thus saving yourself a phone call and arriving at the same end result. 

 
Next, if you provide your employees with a legitimate, unpaid, mandatory break, you 
may select the time to be deducted from each day in which they work more than four 
hours.  Use this with care and after consulting with counsel or the Department of Labor.  An unpaid 

break must generally be at least 30 continuous minutes during which the employee is in a break room or 

otherwise away from job duties. 

 
VolDeductions/hr:  This provides a place to input amounts to be additionally withheld when 

calculating available advances for entertainers and will cause the amount filled in to be deducted from the 

available advance (added to amount collected) from the entertainer for each hour she works.  This might 

be used for loan repayment, health insurance, voluntary savings plans, etc. 

 
Fill in marital status and number of exemptions most recently claimed on the 
employee’s Form W-4.  Note the date this Form was updated, along with the date of the I-9, to later 

get reports on who is out of date.  Pay ID may be used to file another payroll number for this person for 

use by your payroll processor (the file number assigned that person by ADP, Paychex or whoever). 
 
Buttons marked “View” allow you to digitize and attach to each employee’s file a 
copy of their W-4 and such forms.   
 
The Button marked “Transfers” takes you to a subscreen that you may use to enter 
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job transfer data.   
 
The Button marked “Emp. Times” displays Employee Timekeeping data that has 
been entered for this employee. 
  
The button marked “Dancing” displays Dance Shift and Sales Information entered in 
DCT.RW5 for this employee. 
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Personnel Screen: 

Press the Personnel tab to take you to the Personnel screen. 
 

 
 
This screen may be used as you wish to track personnel file information.  Note that 
there are navigation buttons marked “Hire/Term”, “Attendance”, “Evaluations”, 
“Training”, and “OSHA” for entering detailed information.  Click on each of these 
buttons to view or enter information. 
 
Attendance records may be kept by selecting the Attendance icon. 
 
Records of employee training are maintained by selecting the button marked 
Training. 
 
Hire and Termination information is maintained for each employee under the button 
marked Hire/Term. 
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Another important function maintained under the Hire / Term button is the ability to 
maintain a list of Company Property. 
 
The top half of the above screen allows you to maintain detailed records of all 
company property checked out to employees so that this material may be re-
collected upon termination. 
 
Evaluations are entered and maintained under the sub-heading of Evaluations. 
 
 

 
ReportWare facilitates preparation of employee performance reviews.  Look at an 
existing Evaluation by clicking on the green detail button by a date in the Evaluations 
screen.  (Hint:  Suzy, employee 1, has some evaluations).  You may do a new 
evaluation on anyone by selecting a blank line, filling in the date and evaluator, then 
clicking the green button.  All pop up menus are user definable, as is the sample 



 

ReportWare Cabaret Management & Timekeeping © 1995-2001, revised 7/1/2001 Page 27 

(888) 737-9273 

review jargon that’s filled in automatically (and may be edited for each employee). 
 
OSHA filings may be kept under the button marked OSHA. 
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Photo Information Screen: 

Press the button marked Photo & Dates to go to the Photo screen. 
 

 
Use this to track listed information to the extent you wish or feel compelled by the 
EEOC or other agencies.  The EEO race category should not be used without consultation with 

your labor law counsel, but is provided because some clubs are compelled by local laws to keep up with 

this information. 

 
You may add color or black and white photographs (or even movies with sound) to 
any record in the space provided.  The “Select (Add) Photo” button will produce a dialog 

box asking you to locate the computer file of the photo you wish to use.  Digitized photographs may be 

imported in a variety of formats from a variety of sources.  For instance, you can use a video capture board 

to pick a frame from a videotape or video camera, or you may use a dedicated digital camera.  If you have 

a CD-ROM reader on your computer, you may want to take plain 35 mm photos and have your photo lab 

put them on a Photo-CD.  Most graphics software can read Photo-CDs and import them into ReportWare.  

This is cheap in that you don’t have to buy a lot of specialized digital equipment -- and it provides a handy, 

permanent system for keeping photographs.  Your ReportWare representative can provide you more 
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information.  In using the Photo feature, be sure to check the box below for “Store only a reference to the 

file” to keep your database from growing too large.  If you do not elect to store only a reference, the actual 

picture will be added to your database; otherwise, your computer will look for the referenced picture and 

display it whenever you visit this screen. 
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New Hire Reporting 

 
Federal Law is forcing all states to require all employers to report information about 
all new employees hired shortly after each employee’s hire date (within 20 days of 
hire unless your state sets a shorter time).  This is supposed to be for the purpose of 
Child Support Enforcement so that obligated parents can be tracked down and 
support collected from them even when they move around the country or change 
jobs.  Reporting is mandatory in all states after October 1, 1998.  Detailed 
requirements may vary from state to state.  To learn more about this and your state’s 
particular requirements, go onto the Internet and look at  
http://www.acf.dhhs.gov/programs/cse/newhire/employ/employ.htm  
 
Versions of ReportWare shipped after July 28, 1998 support this new hire reporting 
automatically.  There is now a screen on each employee’s detail file under the Photo 
tab for “Dates”.  This screen allows you to review and alter various dates pertaining 
to each employee’s file, including the “Hire Reported for CSE Requirements” date.  
To automatically report new hires for CSE (Child Support Enforcement) 
requirements, go to Reports and click on the button for “CSE New Hires”.  This will 
search your employee files for everyone who lacks a Hire Reported for CSE 
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Requirements date.  It will sort those found alphabetically and print a report which 
you may mail or fax to the state agency with which you are required to file.  After 
generating this report, ReportWare will ask if you’d like to mark those employees 
included in this report as having been filed.  If you select Yes, the current date will 
automatically be inserted into each record included in the report. 
 
When you use this function for the first time, you will not want to report (and are not 
required to report) older existing employees.  To prevent them being reported, run 
the function once, cancel printing, and choose Yes when asked if you’d like to mark 
all as having been filed.  After this, these people will not come up for filing unless you 
remove the date from their records. 
 
The following are excerpts from published rules for Texas 
(other states may be similar): 
 
WHEN TO REPORT 
 
• Send a report within 20 days of the employee’s first day on the job. 
 
• When there has been a lapse in pay of 30 calendar days or more, send a report 

within 20 days of the employee’s first day back at work. 
 
WHERE TO REPORT  
MAIL: 
 Texas Employer New Hire Reporting 
 Operations Center 
 Post Office Box 149224 
 Austin, Texas 78714-9224 
OR 
FAX: 
 1-800-732-5015 
OR 
CALL: 
 1-888-TEX-HIRE 
 (1-888-839-4473) 
 
If you’re not in Texas, you may call the phone number for your state to get detailed 
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local information: 
 

NEW HIRE STATE CONTACTS  
(as of May 1, 1998) 

Alabama  (334) 353-8491  
Alaska  (907) 269-6685  
Arizona  (602) 252-4045  
Arkansas  (800) 259-2095  
California  (916) 657-0529  
Colorado  (303) 297-2849  
Connecticut  (860) 424-5044  
Delaware  (302) 369-2160  
District of Columbia  (888) 689-6088  
Florida  (850) 413-9102  
Georgia  (888) 657-9585  
Guam  (671) 475-3360  
Hawaii  (808) 586-8984  
Idaho  (800) 627-3880  
Illinois  (800) 327-4473  
Indiana  (800) 437-9136  
Iowa  (515) 281-5331  
Kansas  (888) 219-7801  
Kentucky  (800) 817-2262  
Louisiana  (888) 223-1461  
Maine  (800) 442-6003*  
  (207) 287-2886  
Maryland  (888) 634-4737  
Massachusetts  (617) 577-7200, ext. 30488  
Michigan  (800) 524-9846  
Minnesota  (800) 672-4473  
Mississippi  (800) 241-1330  
Missouri  (800) 585-9234  
Montana  (888) 866-0327  
Nebraska  (888) 256-0293  
  (402) 691-9957  
Nevada  (888) 639-7241  
New Hampshire  (888) 803-4485  
New Jersey  (609) 588-2355  
New Mexico  (888) 878-1607  
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New York  (800) 972-1233  
North Carolina  (888) 514-4568  
North Dakota  (800) 755-8530*  
  (701) 328-3582  
Ohio  (800) 208-8887  
Oklahoma  (800) 317-3785  
Oregon  (503) 986-6053  
Pennsylvania  (888) 724-4737  
Puerto Rico  (787) 767-1500  
Rhode Island  (888) 870-6461  
South Carolina  (800) 768-5858  
South Dakota  (888) 827-6078  
Tennessee  (888) 715-2280  
Texas  (888) 839-4473  
Utah  (800) 222-2857*  
  (801) 526-4361  
Vermont  (802) 241-2194  
Virgin Islands  (340) 775-3070  
Virginia  (800) 979-9014  
Washington  (800) 562-0479  
West Virginia  (800) 835-4683  
Wisconsin  (888) 300-4473  
Wyoming  (800) 970-9258  
 
*toll free number only works within state 
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CASHIER – TIMEKEEPING (ENTER TIME AND REVENUE) 

To Enter Dance Time: 

 
Press on the Dance Times button from the Main Menu. 
 
1.  Open Timecards:  Get in the habit of checking for open timecards.  These are 
entries someone has made in which a record was created (someone clocked in), 
but there is no clock out time.  Check this by pressing the “Open Timecards” button 
from the Dance Times screen.  
 

 
 
If you find any open timecards, close them as instructed by your manager.  If there 
are no open timecards, hit cancel.  Check for open timecards regularly!  If there 
aren’t any open timecards, you will return to the screen showing past shifts.  Don’t 
worry about this.  As soon as you set up at least one open timecard and then hit the 
open timecards button, these past shift records will be hidden. 
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2.  Check in Employee:  Push the button “Auto Check-in”.  This takes you to a 
search mode in the Main Employee Database area.  (This whole step may be 
skipped if time is short, but if never used, employee data will become obsolete). 
Basically, you must locate the Entertainer you wish to clock-in, alter personal 
information (phone number, etc.) that has changed (a prompt will display if the data 
hasn’t been updated recently), and check for messages .  Return to the Dance 
Accounting System to clock her in. 
 
 

 
You’ll notice that the screen is quite different from the standard employee 
timekeeping. 
 
This screen is used to clock dancers in and out.  During clock out it is used to track 
their dance and tip revenue as well. 
 
Date and Time in are filled in automatically by the system.  The number of 
cash dances, dollar amount of funny money or scrip is filled in, along with 
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tips declared.  The program uses the employee’s tax information (from the 
personnel file) to calculate the maximum allowable advance and shows how 
much must be collected.  Details showing how the calculations are done are 
accessible by clicking on the View Detail button.   
 
A. The cursor will be in the “Employee File” box.  Type in the person’s SSN, ID 
number, name or nickname, then hit enter.  If no match is found, you will be 
prompted to try again. 
B. Update her phone number or other information, and change the “Data 
Updated” field to the current date (Ctrl + hyphen inserts today’s date).  When 
satisfied with changes, hit the enter key or use the mouse to click “Continue”. 
C. The Dance Time screen now appears, with the person you just looked up 
clocked in.  If the time is inaccurate, you may change it. 
 
3.  Clock IN Entertainers (shortcut): 
If time is short, or you know the employee file information is accurate, the above 
step 2 may be skipped.  Just type “Ctrl N” or hit the New Clock In button to get a new 
blank record in DCT.RW5.  Type in the entertainer’s ID number, hit tab, then verify 
the clock in time. 
 
You have now finished the Clock-in procedure. 
 
4.  To Clock out Entertainers: 
A.  From the Dance Times screen, press the button for “Open Timecards”.  This will 
give you a list, sorted by dance name, you can use to clock out each entertainer. 
B.  Scroll to the entertainer you wish to check out.  Use the mouse to click in the 
“Time-out” field.  Enter the time --you can use “Ctrl ;” (hold the Ctrl key and hit the 
semicolon key) to enter the current time.  Tab to each of the next fields.  Enter the 
number of cash dances.  Collect and count all dance dollars and enter the number.  
Ask the entertainer to declare tips and then enter this amount.  Hit tab to move to the 
next field. 
C.  The computer will calculate all revenue due and estimate taxes that must be 
withheld.  You will be shown a number following “Collect this:”  Get at least this much 
in Dance Dollars and cash (all Dance Dollars, plus any cash needed to make up the 
difference; if she has few cash dances and lots of Dance Dollars, you may need to 
give back the difference in cash.)  
D.  Enter the amount actually collected.  This is cash and Dance Dollars added 
together (it’s cash only if collect as net is selected in preferences).  The Entertainer 
may round up or pay more than the “Collect this:” amount -- she’ll get any excess 
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back in her next paycheck. 
E.  Fill out the paper form with matching numbers, including the “Amount Advanced” 
and have the Entertainer sign the form. 
 
You have now finished with this entertainer. 
 

 
To see a detailed breakdown of the transaction, press the “View Detail” button.  You 
may make entries in this layout if you prefer, and may click on the up or down 
triangle in the top left to flip through records.  You may use either view (as list, or 
detail) to do your work, as you prefer.  The “View Detail” screen also allows 
additional pay in any of three categories to be added.  This might be used for drink 
commissions, T-shirt sales, or whatever you like.  If you have a 3” receipt printer 
hooked up, you may print a receipt for each entertainer by clicking on the “Print” 
button to the right of her information. 
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Using the Credit Card Dance option: 

 
To separately track credit card dances as turned in by waitresses, you should mark 
“Yes” in the Dances Screen in Preferences, as shown below. 
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This will cause a special list view screen for Dance Times to appear when Dance 
Times is selected: 
 

 
The column captioned “CCDances” will list all credit card dances entered.  To better 
enable the database to run rapidly and generate reports more quickly, this amount 
is not dynamically posted to the Dances module, in which Credit Card Dances are 
entered.  Prior to checkout, all credit card dances must be entered.  At checkout, if 
the dancer has credit card dances that have been entered but not posted to her 
check out record, the words “Update” will appear in red beneath the place where her 
credit card dance count appears.  Notice this in the last record displayed above for 
Suzy.  Clicking on the box in which the number of credit card dances appears or on 
the word “Update” will update this number.  By clicking on the number, a detail listing 
of all dances will be presented.  To hide this detail, click on the number again.  
Clicking on the word Update just updates the amount without displaying the detail. 
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With detail selected, a view like this is presented: 
 

 
This displays all line items for which she has gotten credit.  If there are more items 
than will display in the box, you may use the scroll bars to look at them. 

To enter Credit Card Dances 

(You must first set your Preferences for “Separately Track credit card dances” to 
Yes in order to use these functions--this is done in the Preferences setup 
described above) 
To access the Credit Card Dance entry screen, click on the button with the red 
“CC”, labeled Credit Card Dances.  In this screen you may enter credit card dances 
throughout the shift, as they are presented. 
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To enter a new credit card tab for which one or more dancers get credit, either click 
on the New Line button or type Ctrl-N.  On the blank line presented, enter the 
Waitress’ ID number, the Tab ID, Dancer ID, and the number of dances.  If more 
than one dancer gets credit on one tab, use a new line for each.  The date of the 
transaction and time are entered automatically and, for control purposes, may not 
be changed.  Any transactions between midnight and 8 a.m. will bear the date of the 
previous day – the same “fiscal” night. 
 
Dances may be entered in any order and throughout the shift.  Clicking on the little 
gray graph like button will sort the records displayed by the column associated with 
it.  To get back to entering Dance Times or check out dancers, click on the Dance 
Times button. 
 
IMPORTANT NOTE:  If you seem stuck in a screen and the buttons don’t work, or 
information doesn’t enter properly, you are likely out of the the Browse mode.  You 
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must return to this to work.  Hold the Ctrl key down and hit “b”.  Type Ctrl-1 to jump 
out to the Top Menu.  You can also get back to Browse through the pull-down Select 
Menu, or simply type Ctrl-B.  Anytime you seem stuck, type Ctrl-B!  You will never 
hurt anything by hitting Ctrl-B.  You can then hit the buttons to get back to the Main 
Menu.  Ctrl-2 takes you directly to the Main Menu. 
 
Minor discrepancies: 
 
You may occasionally note that sometimes numbers that should add exactly differ by 
a few pennies.  Noticing this means that you have too much time on your hands.  
The reason for this is that this software calculates everything to 15 decimal places, 
then displays it in two.  This rounding effect may cause things to look a tiny bit off 
when they’re not.  For example the number 10.154 will display in currency as 
“$10.15”.  If this sum is multiplied by four, the true answer is 40.616, which will 
display as “$40.62”, seemingly two cents over.  If an error greater than a few 
pennies appears, call for help immediately. 
 
Shortcuts: 
 
There are some quick keyboard shortcuts you can use once you’re comfortable with 
the system: 
 
Ctrl-1 (Ctrl & 1) Jumps to Top Menu in module 
Ctrl-2 (Ctrl & 2) Jumps to Main Menu 
Ctrl-3 (Ctrl & 3) Goes to the Reports Menu 
Ctrl-  (Ctrl & hyphen) Enters today’s date 
Ctrl; (Ctrl & semicolon) Enters the present time 
Ctrl N (Ctrl & n) Creates blank record for new entry. 
Ctrl C (Ctrl & c) Copies information you have  
   selected (highlighted) with the 
   mouse. 
Ctrl V (Ctrl & v) Pastes information you have 
   just copied into selected field. 
 
Pull down the Window Menu to quickly jump back and forth between the modules.  
You can copy and paste between modules. 
 
Manager Control: 
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While working under a manager or greater level password, you may click on the 
“ManagerOR” button in the layout menu to see a list of entries very similar to the 
normal entry list, but with a few new fields.  This screen allows managers to override 
the normal number of housedances by clicking in the HDOR field.  Just to the left of 
this the normal number of housedances is displayed.  The manager places his 
initials in the space provided. 
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 To Enter Employee (non-dancer) time: 

 
Press the Employee Times button from the main menu.  
 
This function gives access to the module to input and track employee clock ins and 
outs.  When you click this, you are presented a list view of existing time  records.   
 

 
 
The ReportWare Employee Time Module is functionally very similar to the Dance 
Time Module.  The basic difference is that, other than time and attendance, different 
information is collected.  Gross sales (from those who are tipped employees or 
subject to tip allocation) should be entered.  Cash tips paid by customers are 
placed in the next field, followed by credit card or other tips processed by the 
employer.  From this information, sales per hour may be displayed. 
 
Note that tipped employees should report their tips.  If they report less than $3.025 
per hour in tips, the employer will have to subsidize their pay (in states that allow tip 
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credit against the minimum wage); if they report less than 8% of their sales, the 
employer will have to allocate tips among employees. 
 
Much like the Dance Accounting System Module, there is a provision for additional 
pay.  This is done in the Detail View, with a provision for Manager’s initials and 
reason or explanation.  A use of this might be a bonus for selling champagne, for 
example. 
 
A couple of reports are unique to the Timekeeping Module:  Sales/hr, which shows 
productivity for selected employees and Cost/hr which can show what the personnel 
cost of operation is at any given time, including at the moment the report is run. 
 
To do a new Clock in, click on the “New Clock In” button.  Enter the Employee ID 
number in the blank record of the list in the screen below. 
 

 
 
The Employee’s position should be filled in.  In some setups, times may not be 
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altered (for control purposes), however adjustments may be made by clicking on the 
“Adjust Punches” button. 
 
ReportWare supports Biometric Hand Readers, Mag Card swipes and other 
timekeeping device interfaces, as well as direct keyboard entry. 
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REPORTING: 
 

Dance Reports 

 

 
Looking over the various reports provided will be more useful than a detailed 
explanation here.  Please note: 
 
1.  Cash Drawer:  ReportWare assumes that a separate cash drawer is used for 
Dancer transactions.  The Cash Drawer Report facilitates balancing this cash 
drawer and locating any discrepancies. 
 
2.  Journal Entry:  This report, especially the Summary Report, facilitates making a 
correct entry into the club’s general ledger to reflect dancer transactions.  It assumes 
that Dance Dollars sold is treated as a liability at the time of sale and reduces this 
liability as Dance Dollars are redeemed. 
 
All reports (for both dancers and non-dance employees) may be accessed by 
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selecting the Reports icon from the Main Menu.   Dance reports may be accessed 
by further selecting the Dance Reports button from the Reports Menu. 
 

 
 
The first step in running any report is to press the Select Data icon.  This will take 
you to a screen used to select which data you wish to appear on your report. 
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Fill in any information to limit the data displayed on your report.  For example, if you 
wish to see a report on a specific employee, you may fill in the name, or SSN, or 
employee id.  When the report is printed, it will select only the data matching the 
criteria that you entered.  If you wish to see all employees, simply leave those fields 
blank. 
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To pull a dance timekeeping report, simply fill in the first date you want, the ending 
date (you may leave the Ending date blank if you only want a report for one day), 
and click on a report.  You may click a radio button to select the order in which you 
want the report sorted and level of detail displayed.  If you want only a specific 
employee or whatever, fill in the applicable box. 
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Cashier Drawer Balancing 

 
From this same Reports menu, cashiers may balance their drawer by entering the 
beginning date of the day that they are working and press the icon marked Cash 
Drawer under the Income column.  This will produce a report to assist the cashiers 
in their drawer balancing. 
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ADMINISTRATION – ADJUSTING TIME 
 
Dancer time may be adjusted by a manager with the proper authority by simply 
typing over the original time in the clock in screen below. 
 

 
 
For all other employees, you must go to the Adjust punches screen by selecting the 
Adjust Punches icon from the Employee Times screen below. 
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This presents the following Adjust Punches screen. 
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For control purposes, the actual punch dates and times may not be altered.  
Adjustments are entered on the next line and adjustments are reflected in the “Will 
Use:” line.  The will use data is what is actually used in all reports and payroll 
calculations. 
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TO RUN PAYROLL 
 
To run the Payroll module, select the Pay Menu icon from the Main Menu. 
 

 
 
 
You may review the Dance Times and Employee Times by pressing the Dance or 
Employee Times icon. 
 
You should know the starting date (usually on a Sunday) of the data you wish to 
process for payroll, and must import it one week at a time from each supporting 
module.  This is much easier than it sounds.  Fill in the first day of the first week, then 
click on the buttons in turn to import Dance Information and to Import other 
Timekeeping.  The software will assemble the chosen information and import it into 
PAY.RW5.  You will see a notice that this is done.  Do this for each week not 
previously imported, but ready for payroll. 
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You will be asked if you wish to run this payroll for: 
 

 
 
You may press the appropriate answer. 
 

 
Review the above report.  Look through the report by scrolling up and down and 
using the notebook icon in the top left corner to flip from page to page.  After looking 
through the report, click continue or hit the Enter key (the Enter key at the far right of 
your keyboard by the number pad, not the carriage return key).  You may print the 
report in the following dialog or cancel printing, as you wish.   
 
Once you press Continue your report will print.  If you select “Export to Payroll 
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Service”, the data will be exported to the payroll service that was setup originally in 
the Preferences Initial Setup under the Payroll button.   
 
Prior to first exporting to ADP or Paychex, you should click on the “Payroll Svc 
Preferences” button in the Pay module to make sure your settings are correct.  This 
will take you to this screen: 
 

 
Here you click in the field beside Payroll Service to select the service you’re using 
from the popup menu.  Enter your company code (assigned you by your payroll 
service), their batch ID and, if you’re using ADP enter codes for the items in the right 
side of the screen. 
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MANAGER’S LOG MODULE 
 
The Manager’s Log Module (MgrLog.RW5) should prove a very valuable 
management tool.  At the end of each shift, the manager on duty should be required 
to take an extra five minutes to full fill out the information about his shift. 
 
To access this function select the Manager’s Log from the Main Menu. 
 

 
Most fields are self-explanatory.  The “Other$” and “Other(2)$” fields can be used for 
whatever you sell that you want separated out for comparison.  Be sure that one of 
them covers everything that is not put into one of the other provided categories to 
get complete income.  If you do not sell food, you may use this field to track 
whatever else you want. 
 
The advertising field should show whatever advertising is in effect that day, for later 
comparisons.  Future promos and reminders can be scheduled by hitting the “New 
Day” button, then changing the date to whatever future date you want.  Then fill in 
applicable fields.  The program is set up to identify and warn against creation of 
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duplicate dates, so if you see a warning about a date, cancel and then “Find” that 
date using the usual find commands. 
 
The Maintenance and Supplies screen provides a handy checklist and free form 
field for comments.  A whole screen miscellaneous field is provided for whatever 
use you choose. 
 
Fill in a few days with dummy or real information, then use “Find” to select a range of 
dates of interest.  (From any screen showing the date, hit “Find”, then fill in a range 
of dates, “1/1/97...1/31/97”, for example.  Be sure to separate dates with three 
periods.)  Then sort the dates using the provided button, in descending or 
ascending order, as you please.  Look at the reports provided. 
 
We suggest you pay special attention to the “Cover Charges” report.  This does 
cover charge comparisons with other numbers, yielding a decimal result.  Over time, 
you will establish norms for these numbers and can be alerted to problems by 
deviations from the norms.  Many clubs can pay for our whole software package just 
by using this feature. 
 
The Advertising Report lets you compare sales and customer traffic with ads you 
are running.  If you don’t already do this in an organized manner, this should help you 
see which advertising has the best effect for you. 
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JOB APPLICATIONS MODULE 
 
The Job Applications Module (JobApp.RW5) helps users track job applicants.  Five 
input screens are provided, using a file tab interface.   
 
To access this function, select the Job Applications icon from the Main Menu. 
 

 
Simply fill in the information in each screen, clicking on the tabs to change screens.  
A blank form job application can be printed from the reports menu, as well as a list 
of applicants. 
 
To best use this module, be sure to fill in the Job Category and Suitability fields on 
the “Position Desired” screen.  To pick out applicants for a report, you might click on 
the Find button at the top of the screen, then select limiting criteria, such as 
“waitress” in Job Category and Suitability of “>7” with a date after (>) a date a month 
ago.  Then hit the sort button to arrange these by date or whatever you please.  Hit 
the report or list buttons to see who to call. 
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UTILITY FUNCTIONS 

Using the Synchronize Files Function 

 
ReportWare provides a function to facilitate synchronizing new records for our users 
who have offices which are remote from the location where timekeeping takes place 
and do not share a network or those users who have multiple locations.  If all your 
computing with ReportWare takes place on the same network, you do not need this 
function and may disregard these instructions. 
 
Remote location setups vary.  A typical arrangement might be a place of business 
where timekeeping records are entered and a remote office where this information 
is collected and assembled for payroll.  Either the office or the business location 
may set up new employees, but both must have complete employee files to function.  
To make this process easier, you may use our Synchronization function as follows: 
 
Your ReportWare operating subdirectory should look something like this: 
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(This is a screen shot from Windows 98 using Small Icons and show extensions and 
hidden files; your view may vary according to what you’ve set in Windows, but all the 
files above should be present.) 
 
Notice that there are some subdirectories called “INbox” and “OUTbox”.  If  these do 
not exist on your computer, you should create them.  Be sure they’re located in 
ReportWare’s working subdirectory and named exactly as above. 
 
Suppose that both the office and remote business location each set up new hire 
files and only the business creates timekeeping records.  The office staff edits and 
corrects both employee files and time records which come up from the business.  
The office will want to get all the new files created at the remote location, but not 
bring in any records it already has, as bringing them in might overwrite existing 
records and destroy corrections made.  Here’s how to accomplish that: 
 
1. Launch ReportWare at the office.  Click on the Utility Functions Button from the 
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Main Menu, then click on the “Synchronize Files with Remote Computer” Button 
on the Utilities Menu.  You will see a screen like this: 

 

 
Click to put a checkmark in the “Employee Files” box and leave the others blank (in 
this example, you only want to send new hire information to the remote location).  
Click on the “Export Sync Files to Outbox” Button.  This will identify new hires who 
have not been previously synchronized and generate small text files containing their 
data, along with that from supporting files, like phone numbers.  These files will be 
created in your OUTbox subdirectory. 
 
2. Now, log on to the remote computer using PCAnywhere or similar remote 

access software.  Launch their version of ReportWare and get to the above 
Synchronization Menu.  For them, put checkmarks in boxes next to each type of 
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file they create.  Click the Export Sync Files to Outbox Button. 
 
3. Leave ReportWare running.   Use the file transfer function in your remote access 

software to “Cut” all the contents of the remote location’s OUTbox subdirectory 
and paste them into the INbox subdirectory on your computer. 

 
4. Cut the contents of your OUTbox subdirectory and Paste them into the remote 

location’s INbox subdirectory. 
 
5. Go back to the above menu on the remote computer and set the checkmarks so 

that only “Employee Files” is checked (because that’s all you’ve sent over from 
the office).  Click on the “Import Sync Files from Inbox” Button.  This will bring in 
the new files and display them for you. 

 
6. Exit the remote access session and go to the above menu on your computer.  

Put check marks in all the boxes for which you have brought in Sync files from 
the remote location.  Click on the “Import Sync Files from Inbox” Button.  This will 
bring in the new files and display them for you. 

 
All done! 
 
How does it work?  Each of the File groups shown in the dialog box has a date field 
called “DSync” which contains a synchronization date.  When you export Sync 
records, the current date is filled in on each record which is copied for export.  The 
Sync function looks for records that lack a Sync date, copies their information out to 
text files (without affecting the original file) and marks the DSync field.  Each record 
imported has its DSync filled in, so it doesn’t accidentally get sent back out.  If you 
goof and lose your Sync files in transit or something, you may search for all files 
synchronized an a particular date and use the Replace function to remove the dates 
from the DSync field.  These files will then get picked up in the next synchronization.  
Be careful doing this, however; misuse could result in duplicate records.  You may 
find the DSync field on employee files here: 
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It’s called “Synchronized with remote location”. 
 
You may also find fields with this function in timekeeping and other files, accessible 
through the View Details Button. 
 
Before you use this function the first time, you should synchronize files in whatever 
manner you have previously used, then launch the function on each computer, 
marking all boxes for Export to Outbox.  This will mark all existing records as having 
been synchronized.  Next, delete the contents of the OUTbox subdirectory on each 
computer.  Enter some new records.  Now when you use the Synchronization 
function, you’ll only pick up these new records. 
 
Because of concern that employee files might accidentally get duplicated, notice 
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that there’s now a function to check for duplicate employee files.  Click on this button 
to bring up a list of any duplicate files which you may delete.  The newer files (those 
just imported) will be deleted and the previously existing files (those you’ve cleaned 
up over the past months) will remain. 
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BACKUPS 
 
You may use any utility to backup your data files.  There are no secret or hidden 
files.  Simply back up each of the modules (the ones followed by “.RW5”) you have 
worked in since your last backup.  It is not possible to make too many backups or 
protect your data too much.  This is a very stable program, but there is no limit to the 
accidents that can happen.  In event of total disaster, remember that all raw data is 
contained in the paper sign in sheets, if they are properly used, and can be rekeyed.  
Payroll should be run and printed at least every other week.  This gives you added 
security. 
 
A simple backup utility is provided from Utilities Button from the Main Menu.  
Clicking on “Make a Copy of All Files” will cause ReportWare to make a copy of 
each file, with a filename preceded by “x”, with a suffix of “.fp5”, placed in the 
working subdirectory.  This will not save you in event of a hard disk failure, but can 
save you from some operator errors. 
 
It is a good idea to make other subdirectories (folders in Macintosh) and daily copy 
your files into these for handy backup.  For example, from the DOS prompt, you 
might type “CD\  [return]” (takes you to main directory), then type “MD RWEVEN 
[return]” then “MD RWODD [return]”.  This will create two new subdirectories.  On 
each even numbered day, backup files into the one, on odd numbered days, use the 
other.  You may backup into these files by using the usual DOS copy command:  
“COPY \ RWEmps\ *.RW5 \ RWEVEN”.  This will copy all ReportWare files (*.RW5) 
from their default directory into the even day backup directory.  It only takes a 
minute, uses a little hard disk space, and can save hours of trouble.  Macintosh 
users:  Just shift-click to select the ReportWare modules in the Finder, then drag 
them to the backup folder while holding down the option key.  You may, of course, 
use Windows copy commands to accomplish this, rather than DOS. 
 
You may use normal commercial backup software, or use the MS-DOS or Windows 
backup utilities to backup to floppy disks, tape drives or whatever.  ReportWare’s 
data modules have no hidden or invisible files.  See your DOS or Windows manuals 
for instructions on using backup utilities. 
 
You can also make backups directly from the program, if you wish.  Under the File 
Menu, choose “Save a Copy As...”, then choose another subdirectory, remote 
server, diskette, or whatever.  This must be done once in each module, and works 
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fine, except that it’s a little slow.  Back up often!!! 
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THEORY AND PRACTICAL CONSIDERATIONS – Employee vs. 
Independent Contractor: 
 
Recent enforcement actions by the United States Department of Labor and Internal 
Revenue Service have challenged traditional methods of accounting for entertainers 
in the Cabaret Industry.  It has been common for management to regard entertainers 
as independent contractors and, depending on the particular club, pay shift pay in 
cash, require the entertainers to “tip out” or actually charge them to work. The 
government has taken the position that all entertainers, not to mention everybody 
else who works in the business, are employees.  This position was officially 
adopted by the United States District Court in the case of Robert Reich, Secretary 
of Labor, United States Department of Labor v. Priba Corporation, et al (the 
“Cabaret Royale” case) decided September 26, 1995 in the Northern District of 
Texas.  If entertainers are employees, then they must be paid minimum wage, have 
payroll taxes taken out, and generally be handled like regular employees in any 
industry, in compliance with the law. 
 
There have been hard-fought battles and court cases.  The end result:  entertainers 
are employees.  Some very recent cases suggest that there is a possibility that 
entertainers may be still be treated as Independent Contractors for IRS purposes; 
there is no doubt that they must be treated as employees for U.S. Department of 
Labor purposes.  If you are confused by this, you are not alone.  Seek advice from 
the most skilled Labor and Tax attorneys you can afford.  For those who have 
chosen not to extract taxes from entertainers on the basis of advice from tax 
counsel, we have added software support for that function. 
 
Actually paying entertainers minimum wage, doing away with tip outs (it’s illegal to 
take an employee’s tips) and all similar means of collecting money (building use 
fees, door fees, etc.), and paying employment taxes dramatically changes the 
economics of cabaret management.  After much work and research, the Labor Law 
Firm of Hensley and King in Austin, Texas came up with a method of doing 
business that preserves the economics of the past and yet complies with present 
laws.  ReportWare has developed software to administer implementation of the 
Hensley and King method of dealing with this thorny matter.  It is far beyond the 
scope of this manual to explain the law and nuances of compliance.  ReportWare 
sells software, not legal advice.  Anyone having questions or needing legal advice in 
employment law matters should select specialized local counsel or may contact 
Hensley and King at (512) 388-6034. 
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We assume that the user wishes to comply with applicable law.  Proper accounting 
and accurate data entry is mandatory.  All table dances sold in your establishment 
should be accounted for and sums paid for these must all be rolled into the club’s 
gross receipts.  Procedures should be implemented to ensure accurate and 
complete reporting of dances.  This system assumes that entertainers are paid by 
the club based upon some function of the dances they perform.  The exact cost of 
dances and pay rates are determined by the individual user. 
 
Very simply put, do the following: 
1.  Fix and post a specific price for all table dances.  Suitable phrasing is:  “[club name] imposes a 

$20 service charge for table dance performances.”  Put this on table tents, etc. and have your 

disk jockey announce this as well. 

2.  Do complete paperwork on all entertainers (as well as other employees).  This includes having 

properly completed Forms I-9 and W-4, as well as applications and whatever paperwork is used 

internally.  Sample forms are provided in the appendix to this manual.  Sample entertainer rules, 

as they pertain to this matter, are provided. 

3.  Set up all employees in the Employee Setup module of ReportWare.  It is not necessary to fill in 

all information, but the more you fill in, the better this software will serve you. 

4.  Ensure that you follow all employment and IRS laws and accurately enter information into this 

software.  This will produce accurate records and leave you happy (or at least willing) to greet the 

Department of Labor or IRS when they come visit you. 
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ADDITIONAL HELPFUL TIPS (For More Advanced Users): 
 
Macintosh Users:  Everything works the same, only easier.  Wherever you see an 
instruction to use the Ctrl key with something, use the Apple (command or 
cloverleaf) key instead.  Forget all the arcane DOS commands -- just copy or move 
files around using the Finder, like with any other program.  All standard Macintosh 
conventions are followed. 
 
All (PC and Macintosh) Users:  
The Main Menu is presented when you first start ReportWare’s Human Resources 
and Timekeeping Software.  This Main Menu may be accessed from any of 
ReportWare’s modules, at any time by typing Ctrl-2.  This screen presents the basic 
user interface for both entering and extracting reports from data.  Buttons provide 
access to companion ReportWare modules and should be used to “open” files.  You 
may later switch between modules using provided buttons or the “Window” menu at 
the top of the screen.  The pull down menu items across the top of the screen are 
standard ReportWare menus.  Take a moment to pull down and examine the 
various menus. 
 
The File Menu will allow you to exit the program, print paper copies, import and 
export data, and perform some backup tasks (“Save As...”).  There is no “save” 
function, since all your work is saved automatically by the software. 
 
The Edit Menu is useful for copying and pasting information from one area to 
another.  Common Windows conventions, Ctrl-C for copy, Ctrl-X for cut, Ctrl-V for 
paste, etc. are supported.  The Edit Menu also allows setting of Preferences for 
networked installations. 
 
The Mode Menu lets you navigate among the three interfaces or modes unique to 
ReportWare.  It is important that you note the distinctions among these three 
interfaces.  Browse is the mode you must be in to enter or edit files.  The Mode 
Menu also allows you to start new records and duplicate or delete existing records 
(use with caution).  If you delete a record, or group of records, they are gone forever 
and cannot be recovered, except by reverting to a backup file you have made.  For 
this reason, low level passwords do not allow deletion of records.  Find brings up a 
copy of the screen you have been working in with blank areas.  You then enter 
information to specify what you are looking for, then hit the Enter key (not the 
carriage return key; the enter key by the number pad at the extreme right side of 
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your keyboard) on your keyboard (or hit the Find Button with your mouse) to search 
for specified information.  You may Cancel searches.  Preview shows what your 
information will look like when it is printed.  You often must be in Preview mode to 
see summary or subtotal information (anything that mixes two or more records and 
produces a result). 
 
The Mode Menu also give access to the Sort command, which lets you arrange 
“found” sets of records in any order you please. 
 
The Select Menu provides means of selecting and omitting records.  Finding and 
Omitting records does no harm; it simply hides certain records so that you may look 
only at those of interest at the moment.  Records that are hidden by a Find or Omit 
command will be displayed when using a Find All command (Ctrl-J) or different Find 
command. 
 
The Format Menu allows for some alternate selection of Fonts.  You will not often 
use this. 
 
The Script Menu gives access to certain automated commands, some of which 
vary from one module to the next.  The first three script items are:  1 Main Data (Ctrl-
1) which takes you to the top menu in the module you are currently in; 2 Main Menu 
(Ctrl-2), which takes you to the Main Menu; and 3 Reports (Ctrl-3), which takes you 
to the Reports Menu. 
 
The Window Menu gives you a shortcut to jump between open modules. 
 
Note near the left top of the screen, there’s a small box which bears the name of the 
layout you are currently viewing.  You may select this by clicking on it with your 
mouse to go to the various layouts provided.  You will seldom need this until you 
grow more familiar with the program, but it does provide an ever present way to get 
back to a familiar screen or jump to another view of the chosen record(s).  Below 
this is what looks like an open notebook lying sideways.  You may click on the open 
pages to go up or down through records one at a time.  Just beneath the open 
notebook is some status information that will make more sense with your use of this 
software. 
 
Various buttons and file folder tabs are provided to assist you in navigating through 
ReportWare.  Click on these with your mouse to move to other layouts, other 
modules, or produce other indicated results.  Click around and see what happens.  



 

ReportWare Cabaret Management & Timekeeping © 1995-2001, revised 7/1/2001 Page 73 

(888) 737-9273 

You won’t break anything. 
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DATABASE PRINCIPLES: 
 
You will enter records into this database.  Each collection of information about a 
specific individual is called a record.  Within each record are fields.  A field holds 
specific information within the record (for example, “first name” or “birthdate”).  
ReportWare’s Human Resource and Timekeeping Software collects a great deal of 
information (many fields) on each individual (record).  To ease screen crowding, 
several screens (Layouts) are used to input all information about each individual.  
Each screen (Layout) presents parts of a single record or series of records, while 
hiding others.  Just because you can’t see some particular bit of information (Field) 
on a particular screen, does not mean it does not exist.  You will find it in another 
Layout.  If you see something (or type something) that does not fit in the display box 
you are looking at, don’t worry, nothing’s lost.  This program will store up to 64,000 
characters of text in any text box, but you may have to scroll through it to see 
everything. 
 
If you are unfamiliar with computer databases, think of it all this way:  Suppose you 
have a big piece of paper with a grid printed on it having hundreds of boxes.  You 
write a different piece of information about an individual (for example: last name, 
first name, phone, etc.) in each box.  You then take an identical piece of paper with 
a grid, but rather than write on it, you cut out some of the boxes and lay it over the 
paper that’s written on.  You can then just see what appears through the holes, and 
the rest of the information is covered up.  If you just had holes over the boxes with 
name and phone number, you wouldn’t have to look over all the other stuff to find 
them -- you’d just lay a template over that covers everything else.  You could erase 
and change the phone number through the hole if you wanted.  Later you might 
overlay a different template to look at names and birthdates, or whatever.  Looking 
through different templates doesn’t eliminate any data that is not shown, it just hides 
it to avoid confusion. 
 
This is what the computer does.  It presents you with different views of information 
for your convenience.  You can select different views by clicking on the box in the top 
left and choosing a different view of your record. 
 
In this software, everything basically happens in a series of simple steps.  First, you 
enter information.  Later, you select or “Find” the records that you are interested in 
(for example, all waitresses).  Then you Sort these records (for example, by last 
name).  You then overlay a template to show you just the particular information you 
want (for example, names of all waitresses, sorted by last name, and showing their 
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phone numbers). 
 
ReportWare automates this process with pre-designed templates and buttons that 
automate finding and sorting information for you, but as you get more comfortable, 
you can look around on your own. 
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TO FIND INFORMATION ALREADY ENTERED: 
 
From the Main Menu, hit the “Find Employee” button.  When in the Folder view, click 
on the “Search...” tab.  Fill in criteria to locate what you want.  SSN will find one 
individual.  To find groups, fill in combinations of information, such as checking the 
yes box by “Currently Employed” and checking the “Day” and “Entertainer” boxes.  
This will find all current Day Entertainers.  You can search for ranges also.  For 
example, to find everybody hired after January 1, 1995, enter “>1/1/95” in the 
HireDate box.  To search over a more limited range, separate parameters with 
three periods (...).  For example, to find everybody hired in February, 1995, enter 
“2/1/95...2/28/95”.  Some boxes present pop up menus to assist you in finding the 
record you want. 
 
You can also “find” information from any Browse screen.  Go to a Layout that shows 
the field(s) upon which you wish to search.  Hit Ctrl-F and then enter the search 
criteria in the chosen fields, then hit Enter.  You may see how many matching 
records were found in the display at left and flip through these by clicking on the 
open notebook at the left.  Change Layouts to see other information about found 
records. 
 
SHORTCUT:  You can drag with the mouse through any single field to select 
information, then hit Ctrl-C to copy it to the clipboard.  You can then paste (Ctrl-V) 
this information into another screen, notably a Find screen, to save typing and 
speed your work. 
 
This software is quite flexible and can distill the information you enter into just about 
any report or list.  If there is something that would help you, please ask us to create a 
report to meet your needs.  Each user’s input is valuable to us and will help us 
evolve a product that serves you better with each upgrade. 
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SUPPORT: 
 
ReportWare provides its customers updates which add new functions and user 
requested improvements.  Be sure you notify us of any changes in your address or 
phone number.  You can reach ReportWare support at (888) 737-9273, 24 hours a 
day, seven days a week.  If no human can take your call, be sure to leave a 
message for a prompt response.  If, at the prompt, you mark your message as 
urgent, one of our staff will be paged to get back to you even more quickly. 
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ReportWare™  MODULES: 
 

ReportWare currently ships with a collection of modules for specific functions.  Your 
CD also includes two Microsoft Excel forms which you may use for Entertainer and 
Employee paper companion form entry and two text files (*.TXT) which are used to 
transfer certain data between the modules.  If the TXT files don’t get loaded, or 
subsequently get erased, don’t worry.  The system will create new text files when it 
needs them.  Do not, however, erase or rename the various module files (*.RW5).  
These all must be located in the same subdirectory. 
 
The Modules are: 
 
!Menu.RW5  This file houses the main menu and various report and utility functions.  
No user records reside in this file. 
aEMP.RW5  This is the Employee Management System, which collects and reports 
on personnel file data.  This is a key module, upon which others depend for 
information.  Much employee data resides here, supported by a number of files 
which provide detail lists linked to this file. 
Phones.RW5  This file houses phone numbers which are displayed in employee 
files.  You will not normally access this file directly. 
Prefs.RW5  This file contains company wide preferences which are set by senior 
management.  This file should be accessed and set to exactly what you want when 
you first start using ReportWare.  Any changes you later make to this file will affect 
all subsequent entries in every module. 
Lists.RW5  This file provides information that is used in Prefs and elsewhere to 
support scrolling lists.  Nothing in this file is directly accessable by users. 
Benefits.RW5  This file holds employee benefit information that is displayed in the 
main employee file. 
CoProp.RW5  This file houses information about company property issued to 
employees.  It is accessed from the Main Employee File (aEmp.RW5). 
TKS.RW5  This file holds and reports on timekeeping, sales, and tip declaration 
data for all employees other than dancers.  It is directly accessible from the Main 
Menu.  This module prepares information for transfer to the payroll front-end 
(PAY.RW5). 
DCT.RW5  This is the Dance Accounting System, used for tracking Dancer times 
worked, sales, tips and advances.  This module allows you to review and correct 
information entered by data entry clerks (cashiers).  This module prepares 
information for transfer to the payroll front-end (PAY.RW5). 
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PAY.RW5  The Payroll module draws information from the DCT.RW5 and 
TKS.RW5 files to assemble a payroll summary.  It draws information from 
aEMP.RW5 to fill in names and other information. 
EmpEvals.RW5  Houses information relating to Employee Evaluations.  It is 
accessed from the Main Employee File (aEmp.RW5). 
Evalist.RW5  Houses information relating to Employee Evaluations.  It is accessed 
from the EmpEvals File (EmpEvals.RW5). 
EmpXfrs.RW5  Houses information relating to Employee transfers.  It is accessed 
from the Main Employee File (aEmp.RW5). 
EmpActs.RW5  Houses information relating to Employee Attendance, vacations 
and the like.  It is accessed from the Main Employee File (aEmp.RW5). 
Jargon.RW5  Houses standard language used in Employee Evaluations.  It is 
accessed through Prefs. 
OSHA.RW5  Houses information relating to on the job injuries. 
Train.RW5  Houses information relating to training and certifications for employees. 
JobApp.RW5  This module is not linked to the others, but is accessed through the 
Main Menu.  This provides a handy way to keep up with job applicants and then look 
them up when hiring time comes. 
MgrLog.RW5  This module, like JobApp.RW5 is little connected to Employee 
Management, but is provided as a bonus for our users.  This gives a place to keep 
organized log entries about the Club’s operations and has advantages over a paper 
form or book in that it can always be found, never runs out of pages, and can be 
downloaded by management from a remote location. 
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SYSTEM REQUIREMENTS 
 

Hardware Information: 

 
ReportWare’s Human Resources and Dance Accounting Systems will run on: 
1.  Macintosh (minimum G3 model with 32 MB available RAM and 20 MB hard disk 
space); 
2.  IBM PC or 100% compatible with at least: 

a. Pentium II class or better processor (the faster the better) 

b.  Windows 95, 98, 2000, ME, XP, or NT 4; 

d.  64 MB RAM 

e.  20 MB available hard disk space; 

f.  VGA graphics or better; 

g.  A Windows supported mouse or pointing device. 

 
This product will operate on IPX/SPX or TCP/IP (recommended) networking 
protocols.  Mixed Macintosh/PC/PowerPC networks are supported.  Remote dial-in 
access is supported with additional software products needed.  
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Software Limitations: 

 
Some general limitations: 
Maximum file size Available disk space 
Number of records per file Available disk space 
Max field size  
 Text  64,000 characters
 Number 255 characters 
Date Range  1/1/001 to 12/31/3000 
100% YEAR 2000 COMPLIANT 
Accuracy  Numeric calculations done to 15 decimal 

places 
Max Networked Users 25 (more with additional software) 
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Import/Export data: 
 
You may import and export data in the following formats: 
 a.  Text, Tab or Comma Separated (*.TAB) or (*.CSV) 

 b.  SYLK (*.SLK) 

 c.  DBF (*.DBF) 

 d.  DIF (*.DIF) 

 e.  WKS (*.WK1) 

 f.  BASIC (*.BAS) 

 g.  Merge (*.MER) 

 
If you wish, for example, to import existing employee files, dump them into a text 
(.txt) file that is tab or comma delimited and includes a header record providing field 
names.  Use ReportWare’s import command to line up field names and make fields 
match for import.  This is really pretty easy. 
 
You may export information as you please.  Buttons have been provided to 
automate export of certain payroll information, but, if you are adventurous, you may 
go far beyond this. 
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Star Receipt Printer 
 
ReportWare’s DCT.RW5 module supports printing of receipts for entertainers on 
Star SP-300, Epson TM-88,  and similar printers using 3” or 3.25” roll paper.  This 
provides a quick and economical means of printing receipts for entertainers as they 
clock out and report their sales. 
 
How it works: 
There is a small “Print” button on each record in list and detail views in DCT.RW5.  
With the printer and cash drawer hooked up, click on the print button.  In just a 
couple of seconds a detailed receipt is printed for the entertainer and the cash 
drawer opens automatically. 
 
It is necessary to use normal Windows printer selection commands to switch 
between the 3” printer and your normal printer -- you probably won’t switch more 
than once a day.  If you try to print a report on one printer that is meant for the other, 
you may get a cut off or funny looking report.  No harm done, just switch printers and 
try again. 
 
Hardware: 
 You need:   
 1.  A Star, Epson, or similar printer that can be driven by your PC. 
 2.  Interface cable for the printer; 
 3.  Software driver for the printer; 
 4.  (optional) a cash drawer that plugs into printer and opens on print. 
 
This has been tested on Star SP-300 and Epson TM-88 printers with and without 
automatic paper cutting.  If you have a modern POS system, you probably have 
several of these printers.  These are very common, print fast, and use cheap paper.  
If you don’t have one laying around, call us to order one. 
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Troubleshooting and Such 
 
Goofs:  It is not uncommon for club level operators to goof on time entry, especially 
clock out times that may be entered a little after the fact.  If you enter an employee in 
at “11:00” this will be read as eleven in the morning, as the computer assumes 
military time unless “am” or “pm” follow the time entry.  If that person is clocked out at 
“7:00”, this will look like she worked 20 hours and clocked out at seven the next 
morning.  Either use military time (recommended) or remember to put “pm” on times 
after noon, whenever these times are typed in manually.  Time errors are easily 
spotted on review and may be corrected whenever they are caught. 
 
Crashes:  If you just turn off your computer without properly exiting this program (you 
should choose “Exit” from the File Menu or use the Quit button on the Main Menu 
when finished for the day), or if you crash your computer or have a power failure or 
other disaster at a bad time, it is possible to damage data files that are in active 
use when the failure occurs.  This software can generally repair these files next time 
they are used -- a message saying “File was not closed properly-- FileMaker Pro is 
performing a consistency check” will appear.  If they are damaged a bit more, they 
may refuse to open.  If this happens, exit and re-launch the program while holding 
down the Ctrl & Shift keys.  This will take you through a file recovery process.  In the 
unlikely event this too fails, something really bad has happened and you should copy 
your most recent backup and use this copy (don’t use the actual backup, because if 
you mess it up too, you’ll get fired).  If you have been backing up properly, you can’t 
lose more than one day’s work. 
 
The most important thing you can do for your computer is get it an 
uninterruptible power supply (UPS)!!  This is a battery back up device that plugs 
into the wall, then your computer plugs into it.  Anyone can put it in—it’s simply a 
matter of plugging it in.  These can be purchased from any good office supply store 
or computer store for around $100.  They keep your computer going whenever the 
power blinks from thunderstorms or other problems and can save your data and 
your computer.  Whether for ReportWare or anything else, you should ALWAYS 
have one of these on every computer you own. 
 
Fonts:  Some of the letters on screen look real weird and are hard to read.  You 
probably installed a new printer, changed the Print Setup... under the file menu, or 
deleted some fonts from your system.  ReportWare uses the following Truetype 
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fonts:  Times New Roman, Arial, Courier.  These seem to be some of the most 
common fonts around and everybody is likely to have them.  If these fonts are not 
installed on your computer properly, the screen may look funny.  Information will not 
be lost, but will be hard to read.  Call tech support for guidance if you cannot restore 
these fonts. 
 
“Collect this” Amounts are extremely low:  If calculations under DCT.RW5 come up 
real wrong, it is possible that somebody closed the Prefs.RW5 or Lists.RW5 files or 
moved them to a different subdirectory.  Locate these files and make sure they are 
in the same directory as the other ReportWare files.  Open these files by clicking on 
the Preferences button from the Main Menu.  Go to the DCT.RW5 file by using the 
Window menu.  “Find” all records for the current day or days that are incorrect.  Type 
Ctrl-0 or select “Recheck Prefs” from the Scripts Menu.  This will re-index 
Preferences and cause calculations to work correctly according to your defined 
rates.  Tell the user before you not to screw around with files they don’t understand. 
 
The computer is running slower and slower:  Your DCT.RW5 and TKS.RW5 files 
grow quite large over time and it takes longer to access large data files.  This will be 
particularly annoying on an older computer that’s slow anyway.  The solution:  
Archive older data by using the “Save as...” command to stick a copy of all 
information in another subdirectory.  After you are sure you have a good backup, 
“Find” all records in the original file that are not currently needed (for example Find... 
Datein <9/1/2000) or whatever.  Select “Delete Found Set” from the edit menu to 
remove these records.  If you later need these old records, access your backup file.
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Tech support: 
 
We pride ourselves on outstanding customer service and are committed to your 
happiness with this software.  If you have any problems, anytime, call our toll-free 
line at 888-REPWARE (888-737-9273).  Someone will answer your call, even 
evenings and weekends.  If no human can answer, leave a message and one of our 
support techs will be paged to return your call. 
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Demonstration Data 
 
This software ships with dummy information in all modules to facilitate 
experimentation and learning.  Dummy employees with Employee ID numbers of 1 
through 7 are provided, as are time, dance, and payroll records for random periods 
for these employees.  Use these to play with the software and see its features.  You 
can go ahead and enter real information while keeping the dummy data to fool 
around with.  When you want to get rid of the dummy data, simply “Find” in each 
module all Employee ID numbers less than 8, then select “Delete All” under the Edit 
menu.  Be careful not to delete your actual records.  If your find request turns up 
nothing, then the dummy records have already been deleted. 
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Main Menu, 8, 9 
Maintenance, 59 
Manager Control, 42 
Manager’s Log, 58 
Mode Menu, 71 
Network, 5 
New Employee, 20 
New Hire, 20, 30 
OSHA, 15, 27 
Password, 7, 18 
Passwords, 16 
Pay, 14, 23 
Paychex, 57 
Payroll, 23, 55 
PC, 71 
Personnel, 25 
Photo, 28 
Phrases, 17 
Positions, 14 
Preference, 12 
Preferences, 9 
Property, 26 
Reporting, 47 
Revenue, 34 
Salaries, 15 
Sales Information, 24 
Script Menu, 72 
Select Menu, 72 
Setup, 9 
Shortcuts, 42 
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Software, 82 
Star Receipt Printer, 84 
Start-up, 5 
Suitability, 60 
Supplies, 59 
SUPPORT, 78 
Synchronize, 61 
SYSTEM REQUIREMENTS, 81 
Tax, 23 
Tech support, 88 
Termination, 25 

Time, 34 
Timecards, 34 
Timekeeping, 34 
Tips, 71 
Training, 25 
Transfers, 23 
Troubleshooting, 85 
UPS, 85 
Utility, 61 
Window Menu, 72 
Windows, 5, 6, 62, 67, 71 

 


